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1. Introduction 
1.1. What is Alwan ColorHub (ACH)? 
1.1.1. Description 
Alwan ColorHub is designed and developed to fit into future standards and working practices which rely on 
the exchange of Standard/Reference data between different parts of the workflow and on the 
adaptation/optimization of data on the reproduction site.  

Alwan ColorHub enables you to improve your color match, print quality and productivity with a fully 
automated color server for all printing processes. 

 

1.1.2. Benefits 
1.1.2.1. Improve Quality 

- Improved Communication with your customers 

Alwan ColorHub recognizes your customer’s expected printed colors and quality requirements (aims and 
tolerances). This information will be used and communicated to each step of the production workflow thanks to 
Alwan Job Color Ticket. 

- Color and Printability enhancement 

More than a color server, Alwan ColorHub Dynamic technology optimizes automatically images and PDF files 
with multiple pages, images and color spaces. The software supports any input and output color space (RGB, 
Gray, CMYK, Spot, Multichannel) for any printing application. By optimizing your files, ColorHub ensures your 
output is predictable and more stable, with unequaled color quality. 

- High-Fidelity Color reproduction 

HiFi by Alwan ensures Spot, wide gamut and multichannel color conversions for High quality printing 
applications with unmatched vibrant colors and accurate spot & brand colors. 

- Standards conformance  

Alwan ColorHub supports the latest industry color management Data Sets, ICC profiles and ISO standards, 
which ensure color standardization through the entire production. 

	
	
1.1.2.2. Improve Efficiency and ROI 

- Ink Saving 

Alwan ColorHub removes unnecessary ink coverage from the separations hence using less ink, improving 
printability and increasing print quality. Ink optimization can reduce the amount of used ink or toner up to 
30%. 
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- Cost Saving 

Ink optimization also enables you to save money on consumables and raw material, eliminating waste. With 
HiFi printing (6 or 7 process inks), Alwan ColorHub can significantly reduce production costs of spot color 
printing. 

- Time-Saving 

Alwan ColorHub automatically analyzes, preflights and optimizes your incoming files and enables you to get 
more productive throughput of files and to achieve faster make-ready and drying times. Ink optimization 
enables the press to run faster without printability problems such as paper brake and jam, causing 
maintenance delays. 

	

1.2. System requirements  
1.2.1. Alwan ColorHub for OS X 
Mac OS X (10.10 – 10.11 – 10.12 – 10.13) / Intel processors 64 bit required (Power PC processors are not 
supported). 

- Standard or administrator user account. 

- Minimum Hardware: Dual Core processor / 8 GB of RAM / 200 GB available hard disc space / 1600x900 
screen resolution. 

- Recommended Hardware: Quad-Core processor / 16 GB of RAM / 400 GB available hard disc space / 
1920x1080 screen resolution. 

To run this application, you need a dongle or a time-limited license code. The demo mode will only be available 
during three months after the first launch of the application. 

 

1.2.2. Alwan ColorHub for Windows 
Windows 64-bit Operating System required (Microsoft® Windows® 7 Pro, 8 Pro, 10 Pro, Server 2008 R2, 
Server 2012 R2, Server 2016). 

- Standard or administrator user account. 

- Minimum Hardware:  Dual Core processor / 8 GB of RAM / 200 GB available hard disc space / 1600x900 
screen resolution. 

- Recommended Hardware:  Quad-Core processor / 16 GB of RAM / 400 GB available hard disc space / 
1920x1080 screen resolution. 

To run this application, you need a dongle or a time-limited license code. The demo mode will only be available 
during three months after the first launch of the application. 

 

1.3. Supported Input File Formats 
Alwan ColorHub supports the following input files formats: JPEG  - TIFF * - PDF   
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By default, Output file format is always the same as the input file format. 

Some TIFF images clipping paths may not be supported. This is particularly true for proprietary technology 
such as Photoshop clipping paths. However, alpha channels are supported. 

	

1.4. Licensing and Editions 
1.4.1. Licensing 
ACH 3.8 and older purple dongles must be upgraded to run Alwan ColorHub version 5. Only Black dongles, 
with a valid URTS (Update and Remote Technical Support Program) are supported. Please contact your Alwan 
Distributor for Dongle upgrade procedure or assistance. In order to prepare an update of your dongle, please 
launch Alwan LicenseManager. 

Click on the button Export Fingerprint File, save the file and mail it to license@alwancolor.com and your Alwan 
Distributor. Alwan will send you back an Upgrade File. Load this file by clicking on the Import Upgrade File... 
button. This will upgrade your dongle.  

	

1.4.2. Editions 
Since version 5.0, Alwan ColorHub is available in 5 Editions: e-media, Premedia, PrePress, Press, ECO and 
Platinum Editions. 

These Editions have increasing capabilities and are adapted to different needs of the graphic industry. 
Depending on the edition you have bought, your dongle will activate the corresponding options of Alwan 
ColorHub. 

Detailed information about each edition options can be found below:  



	

© Alwan Color Expertise 2018                                                    9 / 79                                       ACH_6.5_Manual_v79.docx  

 

Alwan ColorHub
Active Options e-media Premedia PrePress Press ECO Platinum

INPUT - COLOR DEFINITION 
Use Embedded ICC Profiles ✓ ✓ ✓ ✓ ✓ ✓

Use Embedded ICC Rendering Intents ✓ ✓ ✓ ✓ ✓ ✓
Black Point Compensation ✓ ✓ ✓ ✓ ✓ ✓

Default Gray ICC Profile ✓ ✓ ✓ ✓ ✓ ✓
Default Lab ICC Profile ✓ ✓ ✓ ✓ ✓ ✓

Default RGB ICC Profile ✓ ✓ ✓ ✓ ✓ ✓
Default CMYK ICC Profile ✓ ✓ ✓ ✓ ✓ ✓

Static DVLP ★ ✓ ★ ★ ★ ★
Embedded CxF/X-4 Spot Color File ✓ ✓ ✓ ✓ ✓ ✓

Default HIFI  ICC Profile ✓ ✓ ✓ ✓ ✓ ✓

OUTPUT - COLOR REPRODUCTION
ACTION 

Check Only (Preflight) ✓ ✓ ✓ ✓ ✓ ✓
Check and Optimize ✓ ✓ ✓ ✓ ✓ ✓

Optimize Always ✓ ✓ ✓ ✓ ✓ ✓
TRC Adjustment Only ✓ ✓ ✓ ✓ ✓ ✓

COLOR MANAGEMENT 
Output Gray ICC Profile ✓ ✓ ✓ ✓ ✓ ✓
Output Lab ICC Profile ✓ ✓ ✓ ✓ ✓ ✓

Output RGB ICC Profile ✓ ✓ ✓ ✓ ✓ ✓
Output CMYK ICC Profile ✗ ✓ ✓ ✓ ✓ ✓
Output HIFI ICC Profile ✗ ★ ★ ★ ★ ★

CMYK (+Spot) "Separation"  options
Use Output Profile Separation ✗ ✓ ✓ ✓ ✓ ✓

Preserve Original Separations (K dot Gain Compensation) ✗ ✗ ✓ ✓ ✓ ✓
General purpose GCR ✗ ✗ ✓ ✓ ✓ ✓

GCR settings: no K, GCR light, GCR medium, GCR heavy, Maximum ✗ ✗ ✗ ✓ ✓ ✓
Dynamic Maximum Black/Ink Saving ✗ ✗ ✗ ✗ ✓ ✓

Minimum TAC and Ink Usage/Ink Saving Boost ✗ ✗ ✗ ✗ ✓ ✓
TAC value ✗ ✗ ✓ ✓ ✓ ✓

HIFI (+Spot) Additional options
Use Output Profile Separation ★ ★ ★ ★ ★ ★

Minimum TAC ★ ✗ ★ ★ ★ ★
Maximum CMYK inks (TAC, Kstart, Kmax settings) ★ ✗ ★ ★ ★ ★

HYDRA PROFILING
ICC Profile Building (N-Channel / Multi-Separation modes) ★ ★ ★ ★ ★ ★

SPECIAL COLORS TRANSFORMATION 
Spot Color Transformation ✓ ✓ ✓ ✓ ✓ ✓

Device Color Transformation (RGB, Gray, CMYK) ✓ ✓ ✓ ✓ ✓ ✓

TRC ADJUSTMENT  
Dot  Reproduction Limit ✗ ✓ ✓ ✓ ✓ ✓

Tone  Reproduction Curve Adjustment (TRCA) ✗ ✓ ✓ ✓ ✓ ✓
APS/X TRCA Synchronization ✗ ✓ ✓ ✓ ✓ ✓

PURITIES PRESERVATION 
Source Values Preservation options

Chromatic Inks (C, M, Y,…) purity ✗ ✗ ✓ ✓ ✓ ✓
K ink purity ✗ ✗ ✓ ✓ ✓ ✓

Secondary Overprints (CM-MY,…) purity ✗ ✗ ✓ ✓ ✓ ✓
K + Chromatic inks (CK, MK, YK,…) purity ✗ ✗ ✓ ✓ ✓ ✓

K + Secondary Overprints (CMK, MYK, CYK,…)  purity ✗ ✗ ✓ ✓ ✓ ✓
CMY colors under 100% Black ✗ ✗ ✓ ✓ ✓ ✓

All inks at 100% ✗ ✗ ✓ ✓ ✓ ✓
100% solid primaries ✗ ✗ ✓ ✓ ✓ ✓

200% solid secondaries Overprints ✗ ✗ ✓ ✓ ✓ ✓
200% K + Chromatic Ink ✗ ✗ ✓ ✓ ✓ ✓

300% K (or darkest Ink) + Secondary Overprints ✗ ✗ ✓ ✓ ✓ ✓
300% 3-Chromatic Inks without K (or darkest Ink) ✗ ✗ ✓ ✓ ✓ ✓

Advanced Purities options
CMYK colors under 100% Black ✗ ✗ ✓ ✓ ✓ ✓

Preserve Overprints Sensitive ✗ ✗ ✓ ✓ ✓ ✓

ADVANCED 
DVLP  generation Parameters

Maximum DVLP Grid Resolution ✓ ✓ ✓ ✓ ✓ ✓
DVLP Size Calculation (Automatic/Custom) ✓ ✓ ✓ ✓ ✓ ✓

"DTAC" Dynamic output TAC Calculations options
Pixel based calculation method ✗ ✗ ✓ ✓ ✓ ✓

Thickness based calculation method ✗ ✗ ✓ ✓ ✓ ✓
Noise filter ✗ ✓ ✓ ✓ ✓ ✓

Tolerated excess TAC area ✗ ✗ ✗ ✓ ✓ ✓
Nominal TAC area ✗ ✗ ✗ ✓ ✓ ✓

DTAC force ✗ ✗ ✗ ✓ ✓ ✓

"Vector/Linework" Management options
Color Manage like bitmaps ✓ ✓ ✓ ✓ ✓ ✓

Dot Gain management (Automatic/Manual) ✗ ✓ ✓ ✓ ✓ ✓
Keep unchanged ✓ ✓ ✓ ✓ ✓ ✓

Image Enhancement options
Unsharp Mask ✗ ✗ ✓ ✓ ✓ ✓

PROOF  
TIFF/PDF File Generation for Proofing Purposes ★ ★ ★ ★ ★ ★

Print Proof ★ ★ ★ ★ ★ ★

REPORTING TAB
"Ink Consumption" options
Ink Consumption Statistics ✗ ✗ ✗ ✗ ✓ ✓

File assessment and processing text report ✓ ✓ ✓ ✓ ✓ ✓
File assessment and processing PDF report ✓ ✓ ✓ ✓ ✓ ✓

FILE OPTIONS
FILE SETTINGS 

"Format and Naming Policy" options
File Format ✓ ✓ ✓ ✓ ✓ ✓

Embed ICC Profile ✓ ✓ ✓ ✓ ✓ ✓
File Naming ✓ ✓ ✓ ✓ ✓ ✓

Existing File Name ✓ ✓ ✓ ✓ ✓ ✓

"Compression"options
PDF Documents ✓ ✓ ✓ ✓ ✓ ✓

JPEG Images Files ✓ ✓ ✓ ✓ ✓ ✓

RASTERIZATION 
Always Rasterize ✓ ✓ ✓ ✓ ✓ ✓

All Transparencies Rasterization ✓ ✓ ✓ ✓ ✓ ✓
Complex Transparencies Rasterization ✓ ✓ ✓ ✓ ✓ ✓

Overprints Sensitive Elements (OPS) Rasterization ✓ ✓ ✓ ✓ ✓ ✓
Overprinted Spots Rasterization ✓ ✓ ✓ ✓ ✓ ✓

Local Rasterization ✓ ✓ ✓ ✓ ✓ ✓

FILE FILTERING 
PDF/X Transparencies Filtering ✓ ✓ ✓ ✓ ✓ ✓

PDF/X Output Intent Filtering ✓ ✓ ✓ ✓ ✓ ✓

OTHER CAPABILITIES
Log window ✓ ✓ ✓ ✓ ✓ ✓

Automount Manager ✓ ✓ ✓ ✓ ✓ ✓
Job Manager ✓ ✓ ✓ ✓ ✓ ✓

Task Settings Backup and Restore ✓ ✓ ✓ ✓ ✓ ✓
Queue Settings Backup and Restore ✓ ✓ ✓ ✓ ✓ ✓

WORKFLOW IMPLEMENTATION
Hot folder configuration ✓ ✓ ✓ ✓ ✓ ✓

AFP connection (OS X versions only) ✓ ✓ ✓ ✓ ✓ ✓
Samba connection ✓ ✓ ✓ ✓ ✓ ✓

FTP connection ✓ ✓ ✓ ✓ ✓ ✓
One software license per production site ✓ ✓ ✓ ✓ ✓ ✗

Multiple software license  for multiple production sites ★ ★ ★ ★ ★ ✓
Command-line Interface ★ ★ ★ ★ ★ ✓

Included option ✓
Non-Available option ✗

Additionnal chargeable option ★

© Copyright Alwan Color Expertise 2018
Subject to change without Notice
For more details please refer to Alwan ColorHub Manual

Alwan_ColorHub_6.5_Editions_Nov2018
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2. Alwan ColorHub Interface 
2.1. Queue Manager Description 

 

2.1.1. Name 
This tab allows you to define the Queue Name, which must be unique. By doing so, you make your queue 
easily recognizable among others. You can edit the Queue Name whenever you want. 

 

2.1.2. Priority 
This tab allows you to set file processing priority to each queue. 

 

2.1.3. Enabled 
This tab allows you to Activate or not the processing of the selected queue. 

 

2.1.4. Valid 
This tab informs you about the validity of your queue. A valid queue must have working folders available as 
well as appropriated license. A tooltip is displayed on the icon in case of invalid settings. 

 

2.1.5. Description 
This tab allows you to add additional information about your queue. You can explain the goal of the queue or 
talk about ICC profiles in use for instance. 

 

2.2. Queue Manager buttons 
2.2.1. New Queue 
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New Queue button allows you to create a new queue that will have dedicated Task Settings and active Folders. 

 

2.2.2. New Group 
The New Group button allows you to create a new group of queues to organize your workflow in an easy 
way. Gather queues based on the printing process, print sites, or color processing workflows (re-targeting, re-
purposing, ink savings, Special Colors...). 
Group check box activates or deactivates all queues inside a group. 

	

2.2.3. Duplicate 
The Duplicate button allows you to duplicate a queue and related Task Settings. Assign Folders to the 
duplicated queue to make it operational. 

 

2.2.4. Remove 
The Remove... button allows you to delete the selected queue or group from the Queue Manager. 

 

2.2.5. Folders 
The Folders… button will open a window where you will be able to set all needed folders for your queue. 

 

2.2.5.1. Input Folder 

The Input Folder is the place where files can be dropped to be processed with the selected queue Task Settings. 
Alwan ColorHub must have read and write permission on Input Files to process files. 
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2.2.5.2. Output Folder 

Preflighted and/or processed files will be saved in the output folder.  

Output folder default location is in the Input subfolder named JobSuccess. Alternative locations can be defined 
using the Set... button.  

	
2.2.5.3. Report Folder 

Alwan ColorHub can generate a Text and/or a PDF Report for each processing, depending on Output -> 
Reporting choice. These Report files will be saved in chosen Report Folder. 

 

2.2.5.4. Proof Folder 

Files that are proofed by Alwan ColorHub will be stored in the Proof Folder of the corresponding queue. 

	
2.2.5.5. Error Folder 

Files that fail during processing will be stored in the Error folder. 

These files may be corrupted, unreadable or may contain a bitmap exceeding the maximum supported size for 
uncompressed individual images inside a document. 

The default location is in the selected Input Folder, within a subfolder called JobError. Alternative locations can 
be chosen using the Set... button. 

Note that if ACH Action is Check Only (Preflight), Error Folder will contain files that are not complaint (see 
Action part for further details on Preflight policy). 

 

2.2.5.6. Original Folder 

When checked, a copy of each original file is saved into Original Folder of the corresponding queue prior to 
its processing. 

	
2.2.5.7. FTP import 

FTP integration is sometimes the easiest way to integrate existing production workflows, as FTP protocol is 
platform independent. To activate FTP, click on Folders... then FTP... button: 

 

You can either type a hostname or an IP address in the Host field. 
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Note that Relative directory path depends on the path of the folder you have reached/used with an FTP 
connection (you can try first with a terminal, a browser or any FTP client). 

You can also click on the Open URL... button to open a Finder FTP window.  

After Import, Distant files can be remotely deleted if Erase Distant Files option is checked. 

 

The following schema describes FTP import process:    

FTP imports files once only. 

In case of FTP import, we recommend that you configure Alwan ColorHub’s Input Folder locally on the 
computer where Alwan ColorHub is running.  

Alwan ColorHub Input Folder files are deleted after being processed. 

When FTP transfer is active, a green light is displayed on the left of the FTP... button. 

	
2.2.5.8. FTP export 

FTP transfer is also possible from any Output Folder, Report Folder, Proof Folder, Error Folder or Original 
Folder. To do so, Click on the FTP... button: FTP Export settings are similar to FTP Import settings  

The FTP Export process is the following: 

 

In case of FTP export, we recommend that you configure Alwan ColorHub output folder locally on the computer 
where Alwan ColorHub is running.  

Files are exported and are deleted from ACHX output Folder after successful FTP transfers. 

File names containing special characters (/, \, ?, @, etc.) are not supported by FTP connection and transfers. 

2.2.6. Task Settings 
Click Task Settings... button to display Queue Task properties. The Task Settings allow you to define color 
conversion, separation enhancement, and ink savings options. 
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2.3. Job Manager 
This window allows you to view all current and pending operations. 

 

Job Manager displays for each file: Queue Name, Document Name, Size, Task in progress and Completion 
percentage of the Task in progress. 

Multi-processing is done according to Alwan ColorHub preferences. Pending files are waiting in the input 
folder before being moved into the scratch folder for processing purpose. 

Files will be processed according to the First In First Out policy. 

ON/OFF button allows you to start or stop the optimization of all (enabled & valid) queues. 

You can also abort any job processing with a right click on the job and selecting Abort. Aborted file will be 
placed in the Error Folder. 
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2.4. History 
Alwan ColorHub’s Statistics are available in History at the bottom of the Main window. 

 

The History displays the last 100 files processed by Alwan ColorHub. You can display older files by setting a 
different Page number.  

 

At the bottom right of the User Interface, a button Save History... allows users to save a statistics report for all 
jobs contained in the selected time frame. The Report is a tabulated Text file, which can also be opened in a 
spreadsheet for better readability. Statistics Report gives the amount of Ink saved per jobs, and provide more 
insightful details about the ink percentage for every Primary inks before and after optimization, number of 
page per jobs, and total of Ink saved during the selected period of time. 
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Queue Name Name of the queue 

C, M, Y or K (%) Cyan, Magenta, Yellow or Black plate ink coverage in % of 
total (original file) 

Optimized C, M, Y or K (%) Cyan, Magenta, Yellow or Black plate ink coverage in % of 
total (optimized file) 

Delta C, M, Y or K (%) C, M, Y or K (%) - Optimized C, M, Y or K (%) 

Pages Number of pages of corresponding document file 

Area (m2) Total printed surface for the document = Pages (nbr) x pixels 
(nbr) x resolution (dpi) 

C, M, Y or K (Kg) Cyan, Magenta, Yellow or Black ink consumption estimated 
weight (in Kg) = Area (m2) x C, M, Y or K (%) x Ink 
Demand x Print Run. Ink demand figure can be customized 
in Alwan ColorHub Preferences 

Delta C, M, Y or K (Kg) Cyan, Magenta, Yellow or Black ink gain estimated in Kg 

= Area (m2) x ∆C, ∆M, ∆Y or ∆K (%) x Ink Demand x Print 
Run 

PrintRun (nbr) Number of printed copies. Default print run figure can be 
edited for each document by double clicking on the displayed 
number. 

Delta C, M, Y or K ($) ∆C, M,Y or K(kg) x C,M,Y or K inks cost (£/$/€ per kg) Ink 
cost/kg figure can be  customized in Alwan ColorHub 
Preferences 

Savings ($) Sum of Delta C, M, Y and K in £, $ or € 

Total Ink Savings Sum of all individual document files ink savings 

Gain ... %  of initial cost Relative Gain between original ink cost and optimized ink 
cost: Gain = ( Savings (£/$/€)  /   Original Cost  (£/$/€)) x 100 
where Original Cost  (£/$/€) = Original C (Kg) x C (Inks Cost 
per Kg) + M (Kg) x M (Inks Cost per Kg) + Y (Kg) x Y (Inks Cost 
per Kg) + K (Kg) x K (Inks Cost   per Kg) 
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2.5. Options Menu 
2.5.1. Automount Manager 

 

You can launch Automount Manager from the Manager menu. It allows you to automatically mount distant 
volumes on your computer using SMB or AFP protocols. 

In case of network disconnections or computer reboot, Automount Manager will automatically mount again 
distant volumes. 

 

2.5.1.1. Main Interface 

	

Activate or deactivate the Automount manager by clicking on Enabled checkbox. 

You can also Activate/Deactivate each mount by clicking the Active checkbox on the left.   

To create a new Network Drive click on the symbol “+” 

 

2.5.1.2. Setup Interface 
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Protocol: Choose AFP or SMB protocols (For Linux/Windows the usual protocol is SMB. MAC usually uses AFP 
protocol). If the shared Folder is on a Linux/Windows Computer, then select SMB. If it is a Mac to Mac 
sharing, AFP has to be selected. 

Host (required): Type the name or IP address of the distant computer. 

Domain (optional): Fill in the distant computer’s workgroup. This option is useless if you try to access to a MAC 

User Name (required): Fill in the User Name used to access the distant computer. The folder you want to access 
to, has to be shared with this user. 

Password (required if exists): Type the User Name’s associated password. 

Folder (required): Type the name of the distant shared folder you want to access. The disk will only be mounted 
if the folder is shared with the User Named typed before 

Mount Point (OS X version): Will be filled automatically once the OK button is clicked. 

Drive (Windows version): Choose any letter of the list to name your mounted volume. 

 

2.5.2. Log Manager 
This window displays Alwan ColorHub logs, warning and error messages. 

Go to menu Manager -> Log to display the following window: 
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All displays preflight details, warnings and errors encountered when processing a job. 

Warning displays non-critical issues encountered when processing a job. 

Error displays critical issues encountered when processing a job (corrupted file, license issues etc.) 

	

2.6. Admin Menu 
Alwan ColorHub Admin Menu enables you to Backup, Restore, Reset or Lock the software. 

	

2.6.1. Backup and Restore Configuration 
These commands allow users to backup and restore all Alwan ColorHub components (including Queues, 
Preferences, and ICC profiles).  When Backup is restored, ICC profiles are expected to be found from paths 
saved into the backup, otherwise, ICC profiles are restored in:  

- OS X: ~/Library/Application Support/Alwan Color Expertise/AlwanColorHubX/Profiles  

- Windows: User/UserName/AppData/Roaming/Alwan Color Expertise/AlwanColorHubX/Profiles   

Note: Make sure before creating a Backup or restoring a Backup that ICC profiles embedded are royalty free 
and intended for public use. 

2.6.2. Reset Application 
This option allows you to completely reset the application and restart with a clean installation. All previous data 
and settings will be deleted. 
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2.6.3. Lock Interface 
This functionality is useful if you want to prevent users from changing Task Settings. When Lock Interface is 
active, access to Task Settings menu is no longer possible. 

    

 

To Lock the interface you should first change the default password.  
Default Password is “alwancolor” and it does not lock the interface. 
Type Default Current Password (“alwancolor”) and enter a new password twice. 

Finally, Click on Apply button, which will change the password and lock the interface. 
 

To unlock the interface, choose Alwan ColorHub -> Admin -> Unlock Interface... 

    

Then, enter your password in the following window: 

 

Note that if your password is not set to “alwancolor”, the application will start with a locked interface. 

 

2.6.4. Localization 
ACH can be localized using "Admin -> Import Localization File..." menu. Only .qm files are importable 
Please contact your Alwan dealer for more information about Localization file (*.qm) availability 
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Important: 

Language displayed in ACHX depends on computer settings. If a translation file is available in the language of 
the computer, this language will be used by ACHX. Otherwise, English language will be displayed. 

 

This computer setting is editable: 

On Mac OSX, in System Preferences -> Languages & Text -> Region -> Region: 
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- On Windows, in Control Panel -> Region and Language -> Format -> Format: 
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2.7. Advanced Preferences 
General and non-queue specific parameters can be set from Alwan ColorHub Preferences window. To display 
Alwan ColorHub Preferences window choose Alwan ColorHub -> Preferences 

2.7.1. Check for Updates 
Check for Updates option enables Alwan ColorHub to request information about versions available from 
Alwan web server (www.alwancolor.com). An Internet connection is thus required to use this feature. 

If an update is available, it will propose you to download and/or install the latest version you are entitled to 
download thanks to your current URTS expiration date, which is stored on your dongle license. 

If your URTS subscription is expired, Check for Updates feature also informs you about the latest existing 
version, regardless of your dongle URTS. 

Check for Updates settings are available in Preferences -> General -> Check for Updates: 

 

- Check for Updates at Startup option enables the software to launch the Check for Updates scan at each 
startup of the software. 
- Automatically Check for Updates option will perform a Check for Updates every 7 days of running.. 
- Check Now enables you to manually make a Check for Updates. 

You can also directly check for updates through menu Help -> Check for Updates... 

Privacy Policy: 
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-Technical data (date, IP address, Alwan software versions, Alwan Dongle ID) may be stored on Alwan Web 
Server during Software Update requests. No personal information is stored from your computer. 

Such information is held by Alwan and is not for sale or trade, nor will it be disclosed to any third party except 
your Alwan Dealer which may help you during Update processes. 

2.7.2. Web Interface 
Alwan Universal Web Interface is an easy-to-use web based service that allows operators, prepress and quality 
managers to monitor their production in real time. 

Note that it is recommended to ask permission to your network administrator before installing Alwan Web 
Interface. 

2.7.2.1. Activation 

	
2.7.2.1.1. Enabled 

To activate the Web Interface, you have to check Enabled checkbox. 

Please make sure to allow firewall access when the dedicated pop-up window will appear: 
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If you dismissed it, you can activate it through your Firewall settings, through System settings:  

Using Windows:  go to Control Panel -> Windows Firewall  

Using OS X: go to System Preferences -> Security & Privacy -> Firewall 

 

2.7.2.1.2. Port 

Default Port is 8080. 

Port can be customized with another port number if desired. If you customize it, please avoid any port number 
that may be used by another application. 

 

2.7.2.1.3. Username/Password 

Define a Username and a Password if you want a restricted access to the Web Interface. 

If you don’t set any Username and Password, the Web Interface will be “public” on your network. 

 

2.7.2.1.4. Path 

This enables you to define a custom path for the Web Interface addresses. 

 

2.7.2.1.5. Active Address 

Displays the different addresses that allow you to access the Web Interface using an html browser. 

See below an example of browser settings: 
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2.7.2.2. Interface 

The Web Interface of Alwan ColorHub allows you to monitor and take actions on queues, jobs and history, like 
the main window of the software. 

 

2.7.2.2.1. Queue Manager 

The Queue Manager Window displays all queues created in Alwan ColorHub and allows you to 
activate/deactivate each queue and to manage their priority. 

 

2.7.2.2.2. Job Processing 

This window allows you to view all current and pending operations. 
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Job Processing displays for each file: Queue Name, Document Name, Size, Task in progress, Completion 
percentage of the Task in progress and a possibility to Abort the processing. 

Multi-processing is done according to Alwan ColorHub preferences. Pending files are waiting in the input 
folder before being moved into the scratch folder for processing purpose. 

Start and Stop buttons allows you to start or stop the optimization of all (enabled & valid) queues. 

If you Abort a processing, aborted file will be placed in the Error Folder. 

 

2.7.2.2.3. Job History 

The Job History window displays information about all files handled by Alwan ColorHub. You can filter 
available data by Date and Time or by Status. 
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2.7.3. Job Manager 

	
2.7.3.1. Number of files processed simultaneously 

This number enables multi-processing inside the Job Manager. 

Optimal number will mostly depend on your RAM and CPUs, but also on network performance and PDF 
structures. 

Compute button will suggest an optimal figure given your RAM and CPUs characteristics. 

 

2.7.3.2. Input files wait time 

This value should be set between 1 and 240 seconds. This is the time Alwan ColorHub will wait before 
importing a stable file (same size and same modification date) from input folder into Job Manager. This could 
be useful in some networks where “stable” temporary files are generated into Alwan ColorHub input folder. 

 

2.7.3.3. Maximum number of Nested Folders 

This option enables Sub-folders management. 
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If set to “0” directories, only files placed in the input folder will be processed. No folder containing files will be 
optimized. 

If set to “1” directories, all files contained in a sub-folder in ACHX Input folder will be processed and 
transmitted. 

Sub-folders are created according to the original folder hierarchy in output folders: JobSuccess / JobError / 
JobReport / Proof / Original. 

You can set the Maximum of Nested Folders up to 4 directories, to process files inside sub-sub-sub-sub-folders. 

 

2.7.4. Statistics 
The Statistics menu allows you to generate automatically a Statistics report according to a chosen frequency. 
You can choose to get these reports in XML or Tab Delimited Text File formats and customize the path where it 
will be saved. 

2.7.5. E-Mail 
E-Mail tab allows you to configure e-mail parameters for ACH/X. Recommended SMTP ports are: 25, 465, 587. 

 

Those informations are used to send an email to chosen e-mail recipients when: 
- Quality Control -> Comparator -> Send Reports of Files with Differences by Email is checked 
- Input folder of a queue is not available after XX minutes is checked. 
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ACH/X will send an E-Mail alert as soon as Input Folder is unavailable for more than x minutes. For instance in 
case of network disconnection, this notification could alert the manager to avoid any production delay 
because file optimisation stopped. 

 

2.7.6. Advanced 
2.7.6.1. Limit History Data 

 

All reports older than the specified period will be automatically deleted. 

 

2.7.6.2. Scratch Folder 

... button enables you to choose your Scratch Folder. The Scratch Folder is where all temporary items will be 
stored during files processing. 

	

	
	

2.7.6.3. Disk Space Monitor 

By default, Alwan ColorHub Disk Space Monitor gives 2 types of warnings: 

1/ When your available hard disk space containing the Scratch folder becomes less than 60 GB, the following 
warning window is displayed: 
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2/ When your available hard disk space containing the Scratch folder becomes less than 30 GB (default 
value), an Error message is displayed and ACH stops processing files. 

When free disk space becomes sufficient again, the software restarts processing files automatically after a few 
minutes. 

 These 2 thresholds (Default Values: 60GB and 30GB) can be customized in Advanced Preferences thanks to 
Disk Space Monitor: 
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3. Task Settings Interface 
When you create a new Queue in Alwan ColorHub, you have to define its processing settings.  
To do this, select the Queue and click on Task Settings… button.

 

3.1. Overview 
3.1.1. Menu Buttons 

 

On the top left of the Task Settings window, you can find three buttons that allow you to define ACH file 
processing parameters. 

Input: allows to you to define the color management policy for input files and their content.  

Input colors definition depends on these settings. 
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Output: allows to you to define the color management and separation policy for output files  

and their content.  

Output colors reproduction depends on these settings. 

File Options: allows you to define file related processing parameters. 

 

3.1.2. Action 
This menu allows you to define Alwan ColorHub desired action : 

 

 

3.1.2.1. Check Only (Preflight) 

Alwan ColorHub only checks whether files are compliant to your defined Task settings or not. No other action 
on the file is made. Compliant files will be placed in JobSuccess folder while non-compliant files will be placed 
in JobError Folder. 

Parameters checked during Check Only (Preflight) are: 

- Existence of any color space different from chosen Output Color Space.  

- Existence of an embedded profile different from the Output Profile if Use Embedded Profile(s) option is 
checked. 

If your Output Color Space is CMYK, following additional parameters are checked: 

- TAC value resulting from DTAC analysis (Noise filter + Tolerate Excess TAC value) 

- K max (if Separation tab is set to GCR or Maximum Black, in case of CMYK (+ Spot) Output Color Space) 

If your Output Color Space is HiFi, following additional parameters are checked: 

- TAC value resulting from DTAC analysis (Noise filter + Tolerate Excess TAC value) 

Note that if All Inks at 100% preservation option is activated (in Output -> Purities), elements made of all inks 
at 100% will not be taken into account during the Preflight. 

Resulting analysis is described in the Log window. 

	
3.1.2.2. Check and Optimize 

Alwan ColorHub checks and optimizes files and contents of PDF files. The checking operation is done the same 
way as in Check Only (Preflight) mode. 
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If you are processing PDF with Check and Optimize, it is highly recommended to choose Preserve Original 
Separation (to keep the same separation on optimized pages and on pages that do not need optimization). 

 

3.1.2.3. Optimize Always 

All input files are systematically color managed and optimized.  

This option is useful in case you want to change all images color or separation characteristics regardless of  
their preflight analysis. 

	
3.1.2.4. Printer Calibration (Curve Correction Only) 

This option is useful for Press Calibration and Characterization works. 

Data will be compensated according to the chosen TRC defined in Output -> TRC Adjustment, but no color 
management is applied. 

	

3.1.3. Load and Save Buttons 
Task settings management is very useful to save and share your Task Settings with other Alwan ColorHub users. 
Task Settings manages the parameters set for a Task as well as the ICC profiles used within this Task. 

Note: Before exporting and importing settings, please make sure that ICC profiles embedded are royalty free 
and intended for public use. When settings are saved, ICC profiles are automatically embedded. 

Click on the Save... button to save the settings of the current Task window. This button is located at the bottom-
left of the Task window. 

Click on the Load... button to load Task Settings file. This Task Settings file will be applied to the current Task 
window. 

 

To make sure that a Task Settings file is correctly applied, double check names on the top of the Task window: 

The name in the brackets corresponds to the loaded Task Settings file. 
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Note: Loading settings from previous ACO version is only possible if they have been saved with ACH version 
3.9.10 or later. It is highly recommended to check settings after import, because new settings have been added 
in new versions. 

 

3.1.4. Update ICC Profiles List 

 

Update ICC Profiles List button allows you to update the list of ICC profiles available in Alwan ColorHub Profiles 
local menus if you modify the content of one of your local ICC Profiles folder after application startup. 

 

3.1.5. Import ICC Profiles 
Import ICC Profiles… button allows you to import any ICC Profile into Alwan ColorHub database. 

	

3.2. Input (Color Definition) 
The Input Menu allows you to define the color management policy for input files and their content. Input colors 
definition depend on these settings. 

 

3.2.1. Default Definition 
Source profiles generally correspond to the images assumed or known working space. 

You can select Default Profile and Default Rendering Intent for each kind of Input Color Space. 

Alwan ColorHub supports embedded ICC Profiles v2 and v4. 

Black Point Compensation (Default and Embedded): This option will compensate for the differences in dynamic 
range between Input and Output device gamut. 

Blacks and three quarter tones will not be clipped or lost if the Destination gamut is smaller than the Source 
gamut. 

Blacks and three quarter tones will not lose their visual deepness and contrast if the Destination gamut is larger 
than the Source Gamut. 
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3.2.2. Embedded Profiles and Rendering Intents Policy 
3.2.2.1. Use Embedded Profile(s) 

You can choose whether to use or discard ICC profiles that are embedded in input files (except HiFi profiles, 
that can not currently be embedded in files) by ticking the check box or not. In the latter case, selected Default 
ICC Profiles are used as source profiles for color conversions. 

	
3.2.2.2. Use Embedded Rendering Intent(s) 

In case of PDF file processing, you can choose whether to use or discard embedded Rendering Intents. In the 
latter case, selected Default Rendering Intents will be used.  

Black Point Compensation (Default and Embedded) allows you to activate Adobe BPC when applying an ICC 
color transformation. 

3.2.3. CMYK Input 
3.2.3.1. Prefer HiFi C, M, Y, K 

This option is useful for Multicolor PDF Repurposing, including Esko® Equinox® extended gamut PDF. It 
enables ACH to perform automated conversion from any input multicolor space to any output multicolor space. 
Checking this option will force ACH to use the CMYK defined in HiFi Input default Profile, instead of CMYK 
Input default Profile. 

Notes:  
 - This option is only effective if HiFi default profile contains at least C, M, Y or K inks. It cannot works if 
"Automatic Profile" is selected. 

 - If an object (CMYK,  or subset of CMYK) is made of inks not included in HiFi Default Profile, CMYK 
Input default Profile will be used instead of HiFi Default Profile 

 - If PDF has embedded profile(s), CMYK "use embedded profile" has priority over "Prefer HiFi C, M, Y, 
K". Embedded Profile(s) will be used by ACH. 

 - Default CMYK Rendering Intent will be used for CMYK object whatever "Prefer HiFi C, M, Y, K" is 
checked or not. 

 

3.2.3.2. CMYK Input Static DVLP 

Static DVLP is a dongle option.  

It enables you to choose a Static DeviceLink Profile (DVLP) that will be used for CMYK input data processing 
(instead of choosing Alwan Dynamic Generation). 
 

Notes:  
- Static DVLP option is available when output colorspace is CMYK, and dongle option active.  
- Using a Static DVLP instead of Alwan Dynamic Generation may affect overprints. 
- If Default Static DVLP is set to None this option will have no effect. CMYK data will be processed according to 
chosen output separation. 
- With ACHX Premedia Edition, if Default Static DVLP is set to None, data will be processed to the Output 
Profile through a classic ICC conversion, without using any DVLP. 
- Purities and Separation options are grayed when using Static DVLP 
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3.2.4. Gray Input 
If you choose the option Process Gray as K Only, Gray colors will be defined using Default CMYK Profile. 

Gray values will be interpreted as a pure Black value. (Knowing that Gray 0% = Black 100%) 

Note that if Output Color Space = CMYK, Gray PDF objects or Gray Tiff files will be converted into CMYK if 
Process Gray as K Only option is not active. 

If Process Gray as K Only option is active, Gray PDF objects or Gray Tiff files will be saved in Gray Color 
Space after processing, even if chosen output color space is CMYK. 

 

3.2.5. HiFi Input 
HiFi colors are process colors that contain other inks or more inks than just CMYK.  
CMOG and CMYKOGB are examples of HiFi processes.  

Default HiFi Profile enables you to define the color of HiFi / n-color input data. 

HiFi dongle option is needed to choose custom Input Default Hifi profile. Without HiFi option, "Automatic 
Profile" is applied 

Use this option when you are sure that your original file separation and your default HiFi profile match. If they 
don’t, ACH/X will calculate a new input profile that matches your input file channels before converting it to the 
output color space.    

Default and recommended choice is Automatic Profile.  
By choosing Automatic Profile ACH will automatically calculate the input color profile using the color definition 
found in input file data, combined if needed with other Defaults Color Spaces profiles. 

Note:  we recommend that you use the following settings for an optimal HiFi to HiFi separation: 
Output -> Advanced -> DVLP Generation Parameters: 
  Out of Gamut Colors Mapping: Between -5 and -3 
  Force DVLP Resolution to 21 pts 

 

3.2.6. Extended RGB and CMYK Input Gamuts 
Wide Gamut Standard RGB / Super Wide Gamut Standard RGB profiles: can be chosen as default Input ICC 
Profiles to Saturate / Saturate More output colors 

Wide Gamut Standard CMYK / Super Wide Gamut Standard CMYK profiles: can be chosen as default Input 
ICC Profiles to Saturate / Saturate More output colors 

 

3.2.7. Spot Input 
Please refer to part “Default Spot Policy” for explanations about Spot Input options. 
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3.3. Output (Color Reproduction) 
3.3.1. Separation 
3.3.1.1. Output Color Space 

This combo box allows you to choose the Output Color Space for your processed file. You can choose between: 
RGB, Lab, Gray, CMYK (+ Spot) and HiFi (+ Spot) 

 

3.3.1.2. Output ICC Profile (Process Color)  

 

You can select the Output ICC Profile for the queue. Available profiles depend on the chosen Output Color 
Space. 

The output ICC profile should correspond to your desired Reference Printing Conditions (RPC) or match your 
printing process Actual Printing Condition (APC) 

This ICC profile generally corresponds to your destination processes generic or custom profile. 

See part 4. for PDF/X specific cases. 

 

3.3.1.3. Profile Editor 
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Buttons New… and Edit…are available only if the Profile Editor option is activated on your license and 
enables to enter in the Profile Editor. 

Hydra Profile Editor allows you to create an ICC Profile from one or several measured datasets and to choose its 
creation parameters. It also allows you to edit a profile previsouly created with ACH. 

 

Profile Primaries element represents the ink sequence that will be used in the created profile. It is limited to 7 
different inks and is the sum of all selected ink channels used in imported datasets. 

Below, you can import a dataset by clicking on the Import Data… button, you can add another dataset with 
the Add Data Source button and remove it with the Delete Data Source button.  
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When a dataset is imported, ink channels that are included in the file are displayed. You can rename them by 
right clicking on the coloured box. If you make a double click on it, you will enable or disable the ink channel 
for the profile creation. If several datasets uses the same ink channel, they will be averaged for the profile 
creation. 

On the right part of the Profile Editor window, you can select a reference gamut, that will be compared in a 
graph and a table with the profile that will be created. 
Below, the Profile Settings part allows to select options linked to the profile creation, such as the size of its tables 
(A2B Table Size and B2A Table Size) and the Separation (described in below part). 

When Smoothness is checked, ACH will always smooth profile tables. It can be useful if you need to prioritize 
profile’s smoothness over accuracy and foster more evenness in separations. 
When Smoothness is unchecked, ACH applies nevertheless a soft smoothing to profile tables. This ensures good 
accuracy while improving separation smoothness.  

The button Build Profile will start to create a profile with chosen data, settings and the name defined in Profile 
Name. The profile will be available in Alwan ColorHub lists of profiles. 

Notes: 
• To get better results with the profile creation, please give priority to datasets using spectral data, instead 

of Lab one. 
• Imported datasets can contain any number of patches, but of course, you will get a better result the more 

patches you have. However, Hydra Profiling® technology is able to create very accurate profiles with 
few patches, and to generate an IT8/7-4 dataset from any number of patches. You will find it inside 
the profile Under the « targ » tag. 

• If the profile selected in Output ICC Profile list is a profile previously created with Alwan ColorHub X, 
when you click on Create Output ICC Profile, you will find back the data and settings used to create it 
previously. 

 

3.3.1.4. Output Profile Information 

Information about ICC color Separation is extracted from the selected Output ICC Profile and is displayed as 
shown: 

 

K start at 12 % Used for GCR calculations Indicates where black generation starts in relation to cyan channel. 
The value calculated from the output table here is 12%. This means that black will appear where the CMY values 
are approximately 12% or more. This value can be modified when GCR or Maximum Black are selected in 
Separation tab. 

K Max 94 % indicates the maximum amount of Black obtained in the Output Profile separation. 

TAC 329 % Total Area Coverage indicates the maximum amount of CMYK overprint obtained in the Output 
profile separation. 

 

3.3.1.5. Output Separation 
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The Output Separation allows you to take full control on the output file color channels and black generation. 

Some options can be active or grayed depending on the Alwan ColorHub edition used (see part 1. for further 
details).  

For all separation options except Use Output Profile Separation, new separation tables are calculated with the 
chosen output settings. 

3.3.1.5.1. Use Output Profile Separation 

Use Output Profile Separation allows you to use your chosen Output Profile tables separation. 

 

This option is useful if you want to use your Output profile gamut mapping or if you want to obtain the same 
the same color separation as with a standard ICC color conversion. 

 
3.3.1.5.2. Preserve Original Separations 

Only for CMYK (+ Spot) Output Color Space. 

This option allows you to preserve the original black generation of the input file. 

 

With the same ICC profile selected as Input and Output Profile for the queue, the integrity of input separation 
is preserved. Only dark areas exceeding the chosen maximum TAC are recalculated by the software to meet the 
maximum target TAC.  

You can choose to use the K Dot Gain Compensation. If K Dot Gain Compensation is unchecked, output CMY 
values will be calculated keeping original K values, so that original black generation is preserved. 

If K Dot Gain Compensation is checked, output Black channel would be Dot Gain managed using 
Input/Output Profiles black dot gain difference. CMY values are calculated depending on those new K Values. 
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3.3.1.5.3. General Purpose GCR 

Only for CMYK (+ Spot) Output Color Space. 

Output CMYK values are calculated with a General purpose GCR. 

This choice corresponds to a Heavy GCR (1.7), Kstart at 10% and a Kmax at 98% (Kmax was 90% in versions 
previous 3.9) 

 

Displayed TAC default value is extracted from the Output ICC Profile. 

	
3.3.1.5.4. GCR 

Only for CMYK (+ Spot) Output Color Space. 

This option allows you to take full control of your output Black Generation. 

GCR stands for Gray Component Replacement i.e. Black replacing CMY grays in the separation. 

 

All Black Generation parameters can be set. 

TAC (%) Total Area Coverage indicates the maximum amount of CMYK overprint obtained in the Output 
separation. 
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K Start (%) indicates where black generation starts. Black ink component will be generated for colors having a 
L* lower than [100 – K Start]. K start value will also be adapted taking into account profile dynamic range 
characteristics (white and black points). 

K Max (%) indicates the maximum desired amount of Black obtained in the Output separation. 

GCR Level menu allows you to choose the strength of Black replacement.   The range of selection is very wide, 
from No Black (CMY only) to Maximum Black replacement (practically all equal amounts of CMY are replaced 
by equivalent black). 

K out greater or equal to Kin option is available only when input and output CMYK colorspaces are identical, 
and when Separation option is set to GCR or Maximum Black. When activated, this option ensures output 
Black to be greater or equal to input Black. The resulting benefit is that Cyan, Magenta and Yellow values will 
never increase after optimization. 

 

3.3.1.5.5. Dynamic Maximum Black 

Only for CMYK (+ Spot) Output Color Space. 

This option allows you to use the maximum amount of Black ink possible with your print device without 
compromise on print quality including in shadows and three quarter tones areas. 

 

TAC (%) Total Area Coverage indicates the maximum amount of CMYK overprint obtained in the Output 
separation. 

K Start (%) indicates where black generation starts. Black ink component will be generated for colors having a 
L* lower than [100 – K Start]. K start value will also be adapted taking into account profile dynamic range 
characteristics (white and black points). 

K Max (%) indicates the maximum desired amount of Black obtained in the Output separation. For significant 
ink savings, set a high value (90% -100%). 

Ink Savings slider allows you to use the maximum amount of Black ink for your printing process without loss of 
details in shadows and three quarter tones. 

MIN setting is approximately equivalent to Maximum GCR. 

MAX setting allows you to typically save between 10% and 30% more ink in comparison to conventional GCR. 
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K out greater or equal to Kin option is available only when input and output CMYK colorspaces are identical, 
and when Separation option is set to GCR or Maximum Black. When activated, this option ensures output 
Black to be greater or equal to input Black. The resulting benefit is that Cyan, Magenta and Yellow values will 
never increase after optimization. 

 

	
3.3.1.5.6. Minimum TAC and Ink Usage 

This separation is available for HiFi and CMYK Output Color Spaces. 
This option allows you to use the minimum amount of total ink possible to reproduce colors, resulting in 
significant Ink Savings. 

 

K Start (%) and K Max (%) are similar to Dynamic Maximum Black Separation, see previous paragraph 
description for further details. 

TAC (%) Total Area Coverage indicates the maximum amount of ink overprint obtained in the Output 
separation. If dark colors can be reproduced with a lower amount of ink, the TAC separation will be lower 
than the chosen value.  

Minimum TAC and Ink Usage best results are achieved by using Output -> Advanced -> DVLP Generation 
Parameters -> ∆E Mode = ∆E2000 . 

Ink Saving Boost 

Ink Savings can be boosted by activating the Ink Saving Boost. 
If Ink Saving Boost is set to 0 (Min ∆E), Ink Saving are achieved without compromise on color reproduction 
accuracy. It saves a little bit more ink than Dynamic Maximum Black 10 separation. 
If Ink Saving Boost is set to 2 (Min TAC), Ink Saving are boosted, knowing that a small compromise on color 
reproduction accuracy (up to ∆E of 2) is accepted. 

 

3.3.1.5.7. Priority to CMYK Inks 

Only for HiFi (+ Spot) Output Color Space, with a HiFi profile including CMYK inks. 

This option allows you to make a HiFi separation which gives the priority to CMYK inks usage over other inks, 
and, for CMYK inks, it will give the priority to K ink usage over CMY inks).  
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TAC (%) Total Area Coverage indicates the maximum amount of inks overprint obtained in the Output 
separation. 

K Start (%) indicates where black generation starts. Black ink component will be generated for colors having a 
L* lower than [100 – K Start]. K start value will also be adapted taking into account profile dynamic range 
characteristics (white and black points). 

K Max (%) indicates the maximum desired amount of Black obtained in the Output separation. It is 
recommended to set a high value (90% -100%). 

GCR Level menu allows you to choose the strength of Black replacement (GCR).   The range of selection is very 
wide, from No Black (CMY only) to Maximum Black replacement (practically all equal amounts of CMY are 
replaced by equivalent black).  
Please note that GCR stands for Gray Component Replacement i.e. Black replacing only CMY grays in the 
separation. 

 
 

3.3.2. Spot and Special 
Spot and Special options offer two types of color conversions: Spot Color Transformation and Device Color 
Transformation. 

 

3.3.2.1. Spot Color Transformation 

Spot Colors Transformation allows you to define the color management policy for spot colors. You can choose 
if it needs to be converted or not, and how the spot conversion has to be done. 
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+ and - buttons add or remove entries in the list. The displayed list supports multiple selections, and users can 
activate or deactivate each entry by clicking on related buttons. 
Search... field is useful when you have a long Spot Color list. 
Spot Colors can be saved or loaded using Save... and Load... buttons. Supported Spot Colors file formats are 
.txt, *.CxF, *acb, *.tab and *.plist. 

 

3.3.2.1.1. Default Spot Policy 

The first entry is always the Default Spot policy. Default Spot policy will be applied for Spots that are not 
explicitly in the list above. 

Default policy is to Preserve spots with the option: Preserve Spot Ink.  
It can be changed to: 

- Convert to Output Printing Device.  
- Convert using PDF Alternate Color Space Values 
- Convert to output printing device if ∆E00 ≤ x 

Convert to Output Printing Device 

This option converts Spot Colors to the output color space and such definition is chosen as follow: 

 If the spot name belongs to the Input HiFi Profile (i.e. Spot name matches one of the Input Hifi profile 
channel names), icc profile will be preferred for spot color definition. 
 If the spot name does not belong to the Input HiFi Profile, Spot color definition depends on Input -> 
Spot -> Default Definition choice: 
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- Prefer PDF Spot Definition (CxF / Colorant / Alternate Color Space) 

If PDF contains CxF color definition, it will be used. 
If not, PDF Spot Colorant will be preferred if available. 
If not, alternate color space values defined in the PDF will be used to find corresponding Lab value. 

 

- Prefer Color Library Spot Definition 

ACHX will rely on Color Library Spot Color Definition. 

 

Color Library is shared between all ACHX queues. 

+ and – buttons allows you to create colors, import measurement files or libraries and to remove colors from the 
Color Library. Export button allows you export the Color Library to import it in other Alwan software. 
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You can import Photoshop ColorBooks (.acb), CGATS txt, SVF, GMI csv, ISO-28178 xml, DI xml, CxF2, CxF3, 
CxF/X-4 file formats. 

 

Convert using PDF Alternate Color Space Values 

This choice is available only for CMYK Output Color Space. 

When you choose Convert using PDF Alternate Color Space Values, the spot value will be replaced by its 
alternate color space value, and then converted like any other input device color. 

Such conversion matches ACH v3 convert Spots to CMYK purity option. 

If you want to preserve Alternate Color Space Values, it is recommended to choose: CMYK Input Profile = 
CMYK Output Profile, with Preserve Original Separation or Use Output Profile option. 

 

Convert to Output Printing Device if ∆E00 ≤ x 

This option assesses all Spot Colors embedded with incoming files to predict color differences once converted 
into Output ICC Profile. 

If the predicted color reproduction is within specified threshold (x ≤ ∆E), then Spot Colors are converted into 
Output Color Space. 

If the predicted color reproduction of the Spot color has a larger ∆E than the ∆E limit, then the Spot Color is 
preserved as is. 

This option allows to automatically convert all Spot colors into your Output ICC profile as long as they are 
within X ∆E after conversion. 

PDF report depicts color reproduction capability, and expected color difference while informing user on which 
color is whether in gamut or not. 

 
	
 
3.3.2.1.2. Named Spot Policy 
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You can also define a custom Spot Color Transformation: 

 

Becomes Output Value: assigned values will be the output values that you will find in the output PDF. 
Becomes Input Value: assigned values will be used as source device values before the color transformation. 
Color Space menu allows you to choose the color space to be used. 

 

3.3.2.1.3. Spot Color Conversions Diagram 

Following diagram describes Spot Color Conversion summary 

Notes : 
- Converting Spot Colors may affect Overprint properties. 
- When Spot rasterisation is applied, it is recommended to use Convert to Output Printing Device instead of 
Convert using PDF Alternate Color Space Values. 
- Spot Color Rendering Intents rely on HiFi Rendering Intent settings (available from AlwanColorHub task 
Settings -> Input -> HiFi -> Default Rendering Intent).  
Note that Spot 100% will always be converted with Absolute Rendering Intent for maximum color accuracy.  

Conversion Policy

Preserve Spot Ink

- determines if a spot needs to be 
converted or not, and how the spot 

conversion has to be done
- this policy is set within Output -> Special 
Colors -> Spot Colors Tranformation  UI

Convert Becomes Special Values

Spot Color Definition

Spot Color Conversion

Default HiFi Profile PDF Spot Definition Color Library Spot Definition

- HiFi Profile has priority (if Spot name 
matches a Hifi profile channel name)
- Spot Color Definition is chosen from  

Input -> Spot -> Default Definition settings

- if needed Spot Color is then converted to 
ACH output color space using 

Input -> HiFi -> Default RI and BPC
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Other Spot tints (between 0% and 100%) will use a hybrid Rendering Intent (between Absolute and chosen 
Rendering Intent). 

	
	
3.3.2.2. Device Color Transformation 

This option allows you to define custom color conversion for specific Device Color Builds. This option applies 
only to vectors elements (bitmaps and shadings are excluded). 

The Device Color Transformation list can be edited, loaded and saved using Edit..., Load... and Save... buttons. 

To add a new entry, click on + button, then double-click on the new line or click on Edit... button to edit the 
Device Color Transformation: 

 
The New Value replaces the Original value. 

Original color spaces may be Gray (0-100), RGB (0-255), CMYK (0-100) or registration marks All (0-100) 

The Color space used to define the new value is based on the selected Output Color Space for the queue. 

Note that Gray = 0 corresponds to a “black” color, and Gray = 100 corresponds to a “white” color. 

If you choose Becomes Output Value, the original value is replaced by the new value, which is the final value 
that you will find in the optimized PDF. 

If you choose Becomes Input Value, the original value is replaced by the new value, then this new value will be 
color managed like any other input value (the conversion will be "new value" to "Output Color Space"). 

Note that you can define a Tolerance for Original Values. You can set Tolerance from1 to 10 units. RGB units 
go from 0 to 255, whereas CMYK, HiFi and Gray units go from 0 to 100. 

It is also possible to choose Equal Components option for RGB and CMYK original values. 
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In this case, the original R=G=B or C=M=Y=K value is replaced by Black or Gray value only. 

This option is very convenient to optimize Office RGB PDFs for print, but also to avoid registration issues. 

 

3.3.3. TRC Adjustment 
Tone Reproduction Curve Adjustment option allows you to apply sophisticated curve corrections to your files. 
This option is available in two dialogs: Dot Reproduction Limit and Tone Reproduction Curve Adjustment 
(TRCA). 

 

3.3.3.1. Dot Reproduction Limit 

Dot Reproduction Limit allows you to optimize your file tone reproduction to the printing process specifics. This 
enables you to define where dot values should start and stop. This feature can be very useful for some printing 
processes such as Flexo or Screen that cannot reproduce very small dot values lower than 10% or with 
processes that can print better without solids. 

 
 
3.3.3.2. Highlights 

Highlights is the range of tonal values between 0% and 20%.  

Input dot value below (%) defines dot values that you would like to see boosted on the output. 

Become output dot value (%) is the minimum dot value you would like to see in the output file.  

P.S. No dot on input remains no dot on output. 

Below is an example where all input dots that are below 3% should print with 10% dot minimum.  
 
 
 
 

Smooth output curve up to (%) helps to smooth the clipping action of the dot boosting. 
Below is an example of Smooth output curve up to 20% and a Become output dot value of 10%. 
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3.3.3.3. Shadows 

Shadows are the values between 80% to 100% 

Maximum output dot value (%) means that tone values in the output file will be limited to the specified value. 

Below is an example where Maximum output dot value option is set to 85%. This means that all input tonal 
values between 85 and 100% will be limited to 85% on the output. 

 
 

 

Smooth output curve from (%) helps smooth the clipping effect of dot limitation. 

On above example Smooth output curve from is set to 70% with a Maximum output dot of 85%. 

 
	
3.3.3.4. Tone Reproduction Curve Adjustment (TRCA) 

Tone Reproduction Curve Adjustment (TRCA) allows users to apply calibration curves for their printing process 
with ACH/X instead of applying them on their RIP. This can be very useful in 3 cases: 

-Fully automated application of adjustment curves on output files 

-Workflow RIP does not import any TRCA file 

-Workflow RIP does not support HiFi or Spot inks TVI correction 

ACH/X applies TRCA corrections after color management conversions. 

If you want to apply curve correction without any color-management, you can choose Action =  Printer 
Calibration (Curve Correction Only).  

To apply Tone Reproduction Curve Adjustments on your files, please select the channels you want to apply 
TRCA on by checking "TRCA Applied on:" 

A curve is made of a number of points. Each point corresponds to a LUT entry point. You can create new 
entries thanks to the LUT Entries menu. 
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Output profile ink names are displayed with a star* in above list 
Other Spot applies to spot colors that are not color managed and that are not in the list. 
You can also create specific  Spot TRCA by clicking on + button. 

You can edit the different curves within the displayed graph or through the input / output LUT entries values in 
Table tab. 

You can use the Tone Reproduction Curve Adjustment (TRCA) option in 3 different ways: 

- Define your own curve corrections directly in the user interface. 

- Import correction curves (TRCA) generated by Alwan PrintStandardizer or third-party software by choosing 
Manual -> Load… button. 

- Automatically Import TRCA files from Alwan PrintStandardizer into Alwan ColorHub. By doing so, users can 
create a closed-loop system where corrections are automatically applied into ACH/X as soon as 
PRINTStandardizer generates a new TRCA file.   

To link PrintStandardizer to ColorHub, Check Synchronize and select PrintStandardizer TRCA file : 

 

Current TRCA displays date and time of PrintStandardizer TRCA file. 

Load... This button enables you to load a saved TRCA file 
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Save... This button enables you to save a set of TRCA file 

Reset, this button enables you to reset the current changes. 

Lock Curves, check this option if you want to prevent any change. 

Smooth Edited Curve 

This button allows you to smooth the displayed correction curve. The smoothing effect is applied on graphic 
curves and numerical values. Pressing this button many times will make curve smoother and smoother. 

Interpolation Mode 

The selected option determines which algorithm is used to interpolate the values between the different 
points/entries. You can choose between: Polynomial 5, Cubic Spline and Linear. 
Default method is Cubic Spline. 

 

3.3.4. Purities 
This tab lets you set constraints in the output separation in order to preserve the integrity of some of the input 
files values characteristics. It is available with “CMYK (+ Spot)” and “HIFI (+ Spot)” Output Mode only. 

Preserving purities allows you to address printability issues that are encountered when color managing files. 
For all purities options, K stands for black, when no black exists in the process colors, the darkest ink in the 
input and/or output color space will have K channel properties applied to it. 

 

 

3.3.4.1. Source Values Preservation (Image and PDF) 
3.3.4.1.1. Chromatic Inks (C, M, Y…) 

All input chromatic inks except K (or darkest ink) colors of any value will remain pure and without other ink 
contamination on the output. Only dot gain compensation will be applied. For example a 50% Cyan on the 
input may become 54% Cyan only on the output. The output color remains pure Cyan, however its value is 
adjusted to take into account the difference of dot gain between the input and the output profiles. 
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3.3.4.1.2. K (or darkest) Ink 

K stands for darkest ink channel. Typically for CMYK color space, K will be Black ink. 

Darkest ink channel of any value will remain pure darkest channel in output file. 

For example a 40% Black only on the input may become 54% Black only output if this output color space 
includes a channel named Black. If output profile darkest channel is Brown instead of Black, 40% Black on the 
input can become 49% Brown only on the output. 

 

3.3.4.1.3. Secondary Overprints (CM, MY…) 

Input colors composed of two chromatic inks will be composed of two chromatic inks on the output as well. 

If input color space is CMYK and output color space is CMYKOG, CM-MY-YC of any input value will remain 
CM-MY-YC on the output. Only dot gain compensation is applied. 

For example, a C50-M50 (Cyan 50% and Magenta 50%) Blue Color may become C54-M56 on the output. The 
output color remained pure CM, but CM values have been adjusted to take into account the dot gain 
difference between input and output profiles and printing condition. 

 

3.3.4.1.4. K (or darkest ink) + Chromatic Inks (CK, MK, YK…) 

Input colors composed of a mix of the darkest channel (K) and a chromatic channel, will remain pure on the 
output if the same chromatic channel exists in output color space.  

Darkest channel in input and output color spaces can be different (ex. Black channel in input color space and 
Brown channel in output color space). Typically if input color space is CMYK and output color space is 
CMYKOG, input CK-MK-YK only colors of any value will remain pure CK-MK-YK on the output. Only dot gain 
compensation will be applied. 

For example a C40-K90 (Cyan 40% and Black 90%) Blue Color may become C35-K86 on the output. The 
output color remained pure CK, but CK values have been adjusted to take into account the dot gain difference 
between input and output profiles. 

 

3.3.4.1.5. K (or darkest ink) + Secondary Overprints (CMK, MYK, CYK…) 

Tints that are composed of 3 primary inks including the darkest channel (K) and two chromatic inks will remain 
as such if identical chromatic inks exist in the output color space. Only dot gain compensation and black 
generation will be applied. 

For example a C20-M20-K20 (Cyan 20% Magenta 20% and Black 20%) may become C18-M22-K23 on the 
output. 

 

3.3.4.1.6. 3-Chromatic Inks without K (or darkest ink) 

Tints that are composed of 3 chromatic inks without the darkest channel (K) will remain as such if identical 
chromatic inks exist in the output color space. Only dot gain compensation will be applied. 

For example a C20-M20-Y20-K0 may become C18-M19-Y18-K0 on the output. 
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3.3.4.1.7. 100% Solid Primaries 

Input solid primaries remain unchanged in the output separation. For instance input (C0 M100 Y0 K0) stays 
(C0 M100 Y0 K0) on the output, and input (C0 M0 Y0 K0 G100) stays (C0 M0 Y0 K0 G100) on the output. 

 

3.3.4.1.8. 200% Solid Secondary Overprints 

Input solid secondaries (superposition of two chromatic ink solids without black) remain unchanged in the 
output separation. For instance input (C100 M100 Y0 K0) stays (C100 M100 Y0 K0) on the output. 

 

3.3.4.1.9. 200% K (or darkest ink) + Chromatic Ink 

Input colors made of the darkest channel K100 and 100% of other chromatic ink (ex. C100 or M100 or G100) 
will remain unchanged in the output if the same chromatic channels exist in the output color space. For 
instance input (C100 M0 Y0 K100) stays at (C100 M0 Y0 K100) and (C0 M0 Y0 K100 G100) stays at (C0 M0 
Y0 K100 G100). 

 

3.3.4.1.10. 300% K (or darkest Ink) + Secondary Overprints 

Input colors made of the darkest channel K100 and 100% of two other chromatic inks (ex. C100 M100 or 
M100 Y100 or G100 C100) will remain unchanged in the output if the same chromatic channels exist in the 
output color space. For instance input (C100 M100 Y0 K100) stays at (C100 M100 Y0 K100) and (C100 M0 
Y0 K100 G100) stays at (C100 M0 Y0 K100 G100). 

 

3.3.4.1.11. 300% 3-Chromatic Inks without K (or darkest Ink) 

Solids that are composed of 3 chromatic inks without the darkest channel (K) will remain as such if identical 
chromatic inks exist in the output color space. 

For example a G7 Solid (C100 M100 Y100 K0) will not be modified on the output. 

 

3.3.4.1.12. All Inks at 100% 

Input files colors made of (channel1=channel2=...=channelN=100%) remain unchanged in the output file if 
output color space contains the same color channels.  
This option does not affect registration marks made of the “All” special spot color. If you need to convert this 
special spot color named “All” you can edit Special Colors -> Device Color Transformation . 

Output value will be limited to 400% even if output profile contains more than 4 channels to prevent from 
drying problems. 

3.3.4.1.13. Example 
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3.3.4.1.14. Clean Gray Axis 

This option forces the use of only the darkest ink when input colors are close to the gray axis. 

When input colors are close to the gray axis, activating this option will force the use of only the darkest ink in 
output. The value between 0 and 5 defines the Chroma value until which the optimized color will only be made 
of the darkest ink. 

 

3.3.4.1.15. CMY Colors Under 100% Black 

This option handles images having black text defined within the bitmap (for instance a text made of C20 M5 
Y10 K100). 

CMY input values will be color managed and adjusted in the output separation keeping Black to 100%, and 
minimizing the underlying effect on C, M and Y plates. 

This option has been revisited in CMYK Optimizer 3.8 to ensure a better color transformation accuracy and a 
better printability of optimized images. 

This option is only useful when “text” is defined within the bitmaps. 

Please keep in mind that usual 100% Black texts and elements (defined as fonts or vectors) are not concerned by 
this option and will always stay 100% Black even if this option is not activated. 

 

3.3.4.1.16. Classic 

We recommend having a high DVLP resolution grid when this option is active. 

 

3.3.4.1.17. TAC Sensitive 

This option adds a TAC dependent treatment to the Classic method which may enhance shadows & dark tones 
reproduction and give a more accurate output TAC. 

C Purity Preserved

C 100% M 100% Y 100%

K 100%

M Purity Preserved Y Purity Preserved K Purity Preserved

All Inks at 100%
Secondary  
Overprint

K + Chromatic 
Inks

300% 3-Chromatic Inks without K (or darkest Ink)Secondary Overprint

K + Secondary Overprints Preserved 3-Chromatic Inks without K (or darkest ink)
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PS: Please use this option only when needed and very carefully as it may have an impact on shadows & dark 
tones smoothness. 

 

3.3.4.1.18. Preserve Overprints Sensitive 

In some cases where specific CMY purity and overprints are detected, “Preserve Original Separation” option is 
forced. This is to avoid situations where artifacts due to Black generation modification in overprinted regions 
may appear. The consequence of this specific processing is that no ink saving will be achieved for the 
corresponding PDF page. 

When such PDF is processed with this detection active, you will find following warning message in the PDF and 
text reports: 

PDF page contains Overprints Sensitive that force the Preservation of the Original Separation. 

However, if Overprints Sensitive Elements (OPS) rasterization option is checked from File Option -> PDF Page 
Rasterization -> Triggers, it will take the priority over Preserve Overprints Sensitive option, and the chosen 
GCR level will be applied. 

Note also that in the versions of Alwan CMYK Optimizer that are older than 3.8, Preserve Overprints Sensitive 
option was a global setting available in Alwan ColorHub Preference file  

 

3.3.4.1.19. Gamut Corner Points Mapping 

This option only affects RGB objects of the Original File. 

Gamut Corner Point Mapping option will adapt chosen Output Profile to maximize the use of colors present in 
RGB Input Profile. It enables to get more saturated colors in output than with a classic conversion 

Notes:  

- Please be careful when using this option, as it can create unexpected color changes on specific colors, 
depending on chosen Output Profile. 

- It is recommended to use to use "Wide Gamut Standard RGB" or "Super Wide Gamut Standard RGB" when 
Gamut Corner Point Mapping option is checked. 

 

3.3.4.1.20. Preserve CMYK 

Only for HiFi (+ Spot) Output Color Space with Priority to CMYK Inks Separation. 

If this purity option is activated, input colors made of only CMYK channels will remain in CMYK after 
optimization. 

 

3.3.4.1.21. No Complementary Inks 

Only for HiFi (+ Spot) Output Color Space. 

When this purity option is enabled, optimizations will reduce the use of complementary inks to create output 
colors. 
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3.3.5. Advanced 
3.3.5.1. DVLP Generation Parameters 

This menu allows you to set some of parameters having an impact on ACH/X DeviceLink Profiles calculation 
and generation. 

 
 
Default values must not be modified unless you know exactly what you are doing. Please contact Alwan Color 
Expertise or your Alwan dealer if you wish to make changes. 

 

3.3.5.1.1. ∆E Mode 

∆E CIELAB or ∆E94 or ∆E 2000 formulae 

You can choose between these 3 formulae. Default formula is ∆E94. 
Note that ∆E 2000 formula is recommended when using Minimum TAC and Ink Usage separation. 

	
3.3.5.1.2. Maximum Target Error 

Defines the target ∆E for the DeviceLink Profile building calculation.  

Lower ∆E requires more iterations and makes Profile Building longer , however it will increase profile accuracy 
and the quality of color matching. Default value is 0.5. 

	
3.3.5.1.3. Out of Gamut Colors Mapping 

Input Profile may contain colors that are out of the gamut of the Output profile. 

In this case at profile building stage, a choice can be made whether to favor color accuracy or image details in 
the mapping operations: 

Minimum ∆E ensures that output colors will match corresponding input colors as closely as possible. 
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Maximum Details (default setting) ensures that image details on the output will be preserved as much as 
possible. 

	
3.3.5.1.4. Maximum DVLP Grid Resolution (pts) 

Allows you to choose Alwan ColorHub DeviceLink Profiles maximum size. 

The higher the DVLP resolution, the larger the DVL profile, the longer DVL Profile calculation time will be. Default 
value is 11. Available DVLP resolution ranges from 3 to 21 grid points DVL Profiles. 

Forced:   

If Forced option is unchecked, Alwan ColorHub DeviceLink Profiles resolution is limited to the chosen DVLP 
Resolution provided it is lower or equal to the source profile grid resolution. This means that DVLP resolution 
cannot exceed the source profile grid number of points. 

If Forced option is checked, Alwan ColorHub DVL profiles grid points will be forced to the chosen DVLP 
Resolution number.  

	
3.3.5.2. Dynamic TAC Calculations 

Alwan ColorHub analyses and preflights every page of a PDF document.  

Dynamic TAC adds a powerful feature to TAC correction by introducing a new and innovative way of 
automatically calculating and correcting output files TAC. DTAC allows you to calculate and correct your file 
TAC in a dynamic way taking into account the surface of high TAC areas. 

DTAC takes into account the possible risks on printability caused by large black areas and can set your files 
output TAC to values that are lower and more convenient for your print device than the designated nominal 
TAC while maintaining image contrast.  

 

You can choose between 2 methods to calculate high TAC areas: 

- Surface / Pixel based - Basic 

- Thickness / Radial Filter - Advanced 
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With Surface / Pixel based method, high TAC surfaces are calculated using a basic pixel count method. 

With Thickness / Radial Filter method, high TAC value surfaces are calculated using PDF elements thickness. A 
big advantage of this option is that non-adjacent high TAC values regions are not cumulated. 

For instance, with Alwan ColorHub set to Tolerate excess TAC up to 2 cm (in Radial method): 

 - A square of 3 cm x 3 cm will be detected as problematic, 

 - But a rectangle of 1 cm x 9 cm will be OK 

Regardless of surfaces that are both equal to 9 cm2. 

Please note that Nominal TAC designates the TAC value that you typed in the Separation tab interface. 

Note also that Processing a file using Surface / Pixel based method is quicker than processing a file using 
Thickness / Radial Filter method. 

	
3.3.5.2.1. Filter Image Noise up to 

This setting is available only for the Surface / Pixel based method. 

Thickness / Radial Filter method does not offer this option as it recognizes and offsets image noise 
automatically by means of an advanced algorithm. 

Filter Image Noise up to is the maximum percentage of high TAC pixels that Alwan ColorHub will offset during 
TAC analysis. Default value is 0.2%. 

 

3.3.5.2.2. Tolerate excess TAC up to 

Depending on the chosen DTAC method, this value is a surface or a thickness. 

Any entered area (Default 0 cm2) will be tolerated during file analysis preflight.  

This threshold is used during Preflight analysis (In Check Only (Preflight) or Check and Optimize mode) to 
determine if the file needs a TAC reduction. 

For instance, if Alwan ColorHub finds an area, which is less than the designated 4-cm2 areas carrying 
excessive TAC, the file will be considered OK. 

This threshold is also used to determine which TAC value will be applied during the optimization (in Check and 
Optimize, and in Optimize Always mode). 

If the file TAC is below the Tolerate excess TAC threshold, and if the optimization is needed (Optimize Always 
mode for instance), the optimization will be performed by keeping the file original filtered TAC value, instead of 
the chosen Nominal TAC. This is to keep the maximum dynamic / contrast of the original file. You can 
deactivate this option by setting it to 0. 

	
3.3.5.2.3. Keep Nominal TAC up to 

This parameter is used in case of Optimization (Check and Optimize or Optimize Always modes), it determines 
the final TAC of the file, that is to say the output TAC of the DVL Profile used during optimization.  
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Keep Nominal TAC up to value corresponds to the area beyond which Dynamic Output TAC will be active.  

Files having an excess TAC area which is less than this threshold will be normalized to the chosen Nominal 
TAC.  

Files having an excess TAC area which is higher than this threshold will be normalized to a lower TAC value. 
This value is determined by the choice of DTAC Force.  

	
3.3.5.2.4. DTAC Force 

DTAC force correction factor decreases output TAC for pages having dark/black areas above the Keep 
Nominal TAC up to threshold. 

Nil/Min/Medium/Max setting corresponds to Output TAC which can be respectively 0/5/10/15% lower than 
the chosen 300% Nominal TAC. 

The settings above show that if a file has a high TAC area of more than 25 cm2, output TAC will be decreased 
to 285% instead of Nominal TAC.  

This parameter is active for Check and Optimize and Optimize Always.  

Note: decimal separator and area unit (cm <-> inch) are adapted to the OS country, to change them: 

Mac OS: System Preferences -> International-> Formats  

Windows OS: Control Panel -> Region and Language -> Formats -> Additional settings... 

Quit ACHX, change System Preferences unit and relaunch ACHX. 

 

3.3.5.3. Vector / Linework Management 

The Vector/LW tab is active for PDF files.  

It allows you to choose one of the 3 following processing policies for Vector and Linework elements: 

 

	
3.3.5.3.1. Color Manage like bitmaps 
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This is the default and recommended option. 

With Color Manage like bitmaps option, vectors are managed like bitmaps. In this case, Source Values 
Preservation options set in Purity Tab are also effective for vectors. 

 

3.3.5.3.2. TRC management 

Dot Gain Management option enables you to manage Vector and Linework elements with Dot Gain 
corrections. 

 

By clicking on the VDGM... (Vector Dot Gain Management) button you can choose between Automatic (profile 
based) or Manual (custom) dot gain correction. 

These corrections are effective for each C / M / Y and K channel. 

In this case, Printer / Press Calibration button is not effective for vectors. 

 
3.3.5.3.3. Keep Unchanged 

You can also choose to not manage Vectors/LW elements by clicking the Keep Unchanged Button. 

	
3.3.5.3.4. Overprint Knock out when ICC based vector color 

This option enables you to choose how Alwan ColorHub will handle ICC Based vector colors having an active 
overprint. 

If this option is checked, ICC Based vector colors will knock out other elements. 

If this option is unchecked, ICC Based vector colors will overprint other elements. 

For instance, C0 M0 Y0 K100 ICC Based vector color will be optimized: 

- to C0 M0 Y0 K100 Device CMYK if the option is unchecked 

- to C0.2 M0.2 Y0.2 K100 Device CMYK if the option is checked. 0.2% values being added on 0% channels in 
order to force knock out. 
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3.3.5.4. Image Enhancement 

Image Enhancement... option allows you to apply Unsharp Mask to image files or to bitmaps included in your 
PDFs files. 

 

Unsharp Mask is used to improve image sharpness after color separation. 

This filter is based on algorithms that lead to an improved image contrast. 

Unsharp Mask is applied on all images and objects - CMYK, RGB, HiFi and gray - after color conversion. 

Unsharp Mask is effective only in case of Optimization (Optimize Always or Check and Optimize with 
optimization needed or Printer Calibration (Curve Correction Only)). 

 

3.3.5.5. Amount 

This is a percentage that corresponds to the amount of added contrast. Set Amount to 0% to deactivate 
Unsharp Mask. 

 

3.3.5.6. Radius 

Unsharp Mask radius unit is not a pixel (like in Adobe Photoshop®) but printer point, also called DTP point.  

A radius of 1 point corresponds to 1 pixel for an image at 72 dpi. 

A radius of 1 point corresponds to 2 pixels for an image at 144 dpi. 

Image resolution is thus taken into account during Unsharp Mask. 
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Radius Value controls how wide the edge rims become. 

The higher the radius the more noticeable the sharpening effect will be.  

A small radius enhances small-scale details. 

 

3.3.5.7. Treshold 

This value allows you to set the minimum brightness change that will be sharpened. So you can prevent smooth 
areas (like skin, sky, water surface) from becoming speckled. 

Low values should sharpen more because fewer areas are excluded. 

 

3.3.5.8. Preview 

By activating the Preview option, you can see the effect of the chosen Amount and Radius settings. 

 

3.3.6. Proof 
Proof feature allows you to generate a low-resolution RGB files for the Web, to accurately proof optimized files 
on a proofing system, or both simultaneously enabling cross media workflows with Alwan ColorHub.  

Generated Proof files are saved in the Proof Folder (selected in the Queue Manager, Folders...) 

 

 

3.3.6.1. Generate Proof 

Check Generate Proof to activate the proofing option for the selected queue. 
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3.3.6.2. Proofer Profile 

Proofer Profile is the output ICC profile used to convert the optimized file into the proofing color space. This 
ICC Profile can be any type of color space (RGB, CMYK, Gray, CIELab, N-channel). 

For hard proofing purpose, the proofer ICC profile should be targeted. 

For web purpose, you can choose an RGB profile such as sRGB. 

	
3.3.6.3. Rendering Intent 

This is the Rendering Intent of the ICC color transformation used to generate the proof file. 

	
3.3.6.4. Resolution 

The resolution can be set to the desired output resolution. The optimal setting is usually the proofer optical 
resolution or proofer resolution / integer number to save printing time (example 720 dpi or 360 dpi or 180 
dpi...). DPI (Dots per Inch) is the unit used to define the output resolution. 72 dpi can be an appropriate 
resolution to display on a website purpose while not suitable for hard proofing purpose. (1200 dpi is the 
upper-limit) 

	
3.3.6.5. Auto Rotation 

Rotate the page according to the chosen Page Setup orientation.  

 

3.3.6.6. 90° Rotation 

Rotate the document 90°. (Counterclockwise) 

 

3.3.6.7. Save TIFF LZW 

TIFF LZW proof file is saved in Proof Folder. 

 

 

3.3.6.8. Save PDF 

PDF proof file is save in Proof Folder. 

 

Users can choose between 3 compression methods: 

Raster Flate: the file is saved with a lossless compression method (ZIP) 
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Raster JPEG: the file is saved with a lossless compression method (JPEG) equivalent to the High Quality option 
in Adobe® Photoshop. 

Raster JP2000HQ: the file is save with JP2000 algorithm. 

 

Note: you can save simultaneously both TIFF and PDF files if needed. 

 

3.3.6.9. Print Proof 

Click on Print Proof checkbox to print the output file on the printer chosen in Print Panel... using the printer 
driver. (Setup button) 

 

3.3.6.10. Auto Fit 

Resize file size to fit in the chosen paper format (Setup button) 

	

3.3.7. Reporting 
3.3.7.1. Ink Consumption Statistics  

Only for ECO and Platinum Editions. 

Ink Consumption Statistics option enables you to view your individual files calculated ink consumption as well 
as any increase or decrease in this consumption due to your optimization settings.  

You can activate this feature by ticking the relevant check box. 
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3.3.7.1.1. Ink Demand 

Average weight of nominal solid ink density printed on 1 m2 of paper (before drying). This figure is process and 
paper dependent. Its value can fluctuate from 1-2 gr/m2 for an offset process to 7-8 gr/m2 for gravure or 
flexographic process. 

 

3.3.7.1.2. Default Print Run 

This is the default number you will find under the Print Run column in the Reporting section of Alwan ColorHub 
main window. 

 

3.3.7.1.3. Ink Cost 

Ink cost per kg. Enter actual figure if available. If not, default figure is 4 £/$/€ per kg for Black and 5.5 £/$/€ 
per kg for C M Y.  

	
3.3.7.2. PDF and Text Reports Generation 

Each time a file is processed by Alwan ColorHub, a report is generated in the chosen Report Folder. You can 
disable any kind of Report Generation (PDF or Text) by unchecking the corresponding checkbox. 

	

3.4. File Options 
	

	

3.4.1. File Settings 
3.4.1.1. Format and Naming Policy 
3.4.1.1.1. File Format 

You can choose between: Automatic, PDF, JPEG, TIFF and TIFF LZW. 

Automatic format means that each processed file will keep its original file format. 
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Please note that JPEG output File Format is only available for RGB and CMYK (+ Spot) Output Color Spaces. 

Note that if the input file is PDF, the processed file format will always be PDF regardless of File Format choice. 

 
3.4.1.1.2. Embed ICC Profile 

 

You can choose between the following options: 

Do not Embed Profile: No profile is embedded in the optimized file. 

Embed ICC Profile as is: Selected Output Profile is saved in the optimized file. In case of PDF-X files, output 
profile is saved as PDF Output Intent. 

 

3.4.1.1.3. File Naming Policy 

It is possible to have a comprehensive file naming management. 

You can Keep Original File Name Unchanged or choose to add a prefix and / or a suffix to Original File 
Name. 

The bottom part Existing File Name enables you to choose whether or not you want to overwrite existing files 
having the same name in the output folder or not. 

With Add a Number after new File Name (_01.ext) option, an incremental suffix will be added to your 
optimized file name.  

For instance, MyJob.pdf will become MyJob_01.pdf in the Output Folder. If you place MyJob.pdf into the same 
hot folder a second time, it will be processed and saved as MyJob_02.pdf under the Output Folder. 

	
	
3.4.1.2. Compression 

Compression can be applied on output files. This applies to PDF and JPEG output file formats. 

The compression algorithm used is JPEG_DCT and is applied on bitmaps inside PDF, or on JPEG image files. 
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The top part of the window allows you to set PDF output file formats. 

A drop down menu offers three options for handling compression within a file: 

Compress none (flate): no DCT compression is applied. However, a Zip (non destructive) compression is 
applied. 

Compress if required: compression is applied only to images that were compressed inside the original PDF. 

Compress always: all images are compressed regardless of whether they are originally compressed or not. 

Under each slider, you can see the labels low, med,  high and max 

  

These presets are almost equivalent to Adobe Photoshop® JPEG compression presets. 

The compression slider under JPEG Image Files allows you to set compression on Jpeg images only. 

A value greater than 6.0 is recommended to avoid visible image quality loss. 

 

3.4.2. Rasterization 
This Tab allows you to choose which element in PDF will trigger Page Flattening and Rasterization and the 
applied resolution in this case. 
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3.4.2.1. PDF Page Rasterization Triggers 

This part allows you to choose which kind of PDF elements can trigger Flattening and/or Rasterization of a PDF 
Page. 

 

Always rasterize: 

All pages will be rasterized regardless of the PDF content. The whole page is rasterized in a unique Bitmap. 

If Always rasterize is checked, other triggers are grayed and Whole page rasterization mode is forced. 

All Transparencies: 

Detect if PDF contains Transparencies. In case of multipage PDF, only pages with transparencies will be 
flattened and/or rasterized. 

Complex transparencies: 

Detect if PDF contains Complex transparencies (i.e. non-normal blending mode) that may be misinterpreted on 
the RIP. In case of multipage PDF, only pages with transparencies will be flattened and/or rasterized. 

Overprint Sensitive Elements (OPS): 

Detect if PDF has pages that contain complex tints and overprints that may be misinterpreted on the RIP. In case 
of multipage PDF, only pages with OPS will be flattened and/or rasterized. 

Overprinted Spot: 

Overprinted Spot detects if PDF has a Spot Color overprinted by another object(s). 
If spot is converted to Output Printing Device, the option has no impact. 
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Note that for All Transparencies and Complex Transparencies Triggers, flattening can be applied without 
rasterization if this is enough to preserve PDF integrity. 

 
3.4.2.2. Rasterization Settings 

This part allows you to choose resolution of bitmap created by Alwan rasterization. 

 

Local Rasterization: 

Local rasterization allows you to rasterize limited areas and prevents from to rasterizing the whole Page. The 
benefit compared to whole page rasterization is that created files are lighter, and non problematic areas 
remain intact. Flattening is always applied before local rasterization with settings that are equivalent to default 
Adobe Acrobat Settings. 

Whole Page Rasterization: 

This option will rasterize the whole page in a unique bitmap at a defined ResolutionResolution (dpi): 

This option allows you to choose Rasterization resolution. The resolution set will be applied for Local 
Rasterization or Whole Page Rasterization. Unit is dot per inch (dpi) and default value is 900 dpi.  

Anti-Aliasing: 

If you check this option, Anti-aliasing is applied during rasterization. Anti-Aliasing is a technology for 
smoothing and reducing stair step effect after rasterization. 

 

 

3.4.3. File Filtering 
3.4.3.1. PDF/X Transparencies Filtering 

PDF/X Transparencies Filtering menu allows you to choose if a PDF having transparency should be processed 
or not, and whether it should be outputted in JobSuccess or JobError folder. 

Note that this option takes priority over File Options -> Rasterization -> PDF Page Rasterization Triggers 
Transparencies options. 
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Above settings are the Default and recommended options, meaning that a PDF having transparencies will be 
optimized and saved in job Success folder. 

 

By choosing the above settings, a PDF having transparencies will not be optimized and will be saved in job 
Error folder. 

 

By choosing the above settings a PDF having transparencies will not be optimized and will be saved in job 
Success folder. 

Note: 

You can see detected transparencies logged into text reports (“Page 1/1 contains transparencies”). 

	
3.4.3.2. PDF/X Output Intent Filtering 

The PDF/X Output Intent Filtering menu is useful to replace an identified Output Intent that you consider 
irrelevant. 
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If you choose to use embedded profile option and if you put the above example, Alwan ColorHub will use any 
PDF Output Intents as input profiles except if the Output Intent is GWG_GenericCMYK. In this case, the 
Output Intent is replaced by an ISO Coated v2 profile, which will be used as Input Profile. 

You can set the Filter to: 

Contains (entered filter is part of the Output Intent)  

Starts with (entered filter matches the beginning of the Output Intent) 

Whole Words (entered filter matches exactly the Output Intent) 

Ends with (entered filter matches the end of the Output Intent) 

 

3.4.4. Quality Control 
File Comparator is a quality control tool designed to increase security level when it comes to processing high 
volume of files in industrial environment. File Comparator evaluates original and optimized files to detect visual 
and perceptible differences between the two. Notifications can be reported in PDF report, User Interface 
(History/Status), and by email. This tool works with any input format, and it is not restricted to PDF. 

Users can activate File Comparator for each Task Settings by going to File Options ->  Quality Control and 
ticking the Comparator checkbox. 

Comparator feature relies on advanced image recognition algorithms to increase quality insurance in 
production. Depending on file size and other parameters, this feature - in average - can double ACH 
processing time. 
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Users can choose Comparator sensitivity through the slider from Flexible to Strict. (Medium is the default and 
recommended settings for most applications). 

ACH reports differences detected by the Comparator in the History section of the Main Interface, under Status 
category as Differences detected. When evaluation is completed, ACH moves files into JobSuccess folder unless 
specified otherwise. 

 

ACH can move optimized files into Error folder when differences are detected by ticking the Put files with 
Differences in Error checkbox. 

 

In addition, ACH can also send a report by email when differences are detected. In this case, Users must have 
set up email parameters in ACH Preferences -> E-mail prior activating this option. 

Processing time can be longer when using the File Comparator due to CPU demanding computation. 

 

 

3.5. Color Library 
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Alwan Color Library enables you to define or import specific colors, which could be used to convert a Spot 
Color in your Output print Device Colour Space. 

The choice of giving priority to Alwan Color Library Spot Definition to convert spot Colors has to be done in 
Input -> Spot tab. 

 

On the left side of Color Library you can choose to import, create, edit, delete or export colors. 

Import button enables you to import Photoshop ColorBooks (.acb), CGATS txt, SVF, GMI csv, ISO-28178 xml, 
DI xml, CxF2, CxF3, CxF/X-4 file, X-Rite MIF file formats. 
If measurement file contains different patches of the same solid, CIElab, Spectral and density values will 
be automatically averaged. 
If color from this file already exists inside your Color Library, user can choose to Replace or Keep Existing color. 

Export button will export selected colors in a .cxf file. 
You can select several Colors to export them in a single .cxf Color Library file.
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4. Advanced 
4.1. ICC Profiles 
4.1.1. ICC profiles used by Alwan ColorHub 
Under Mac OS X Alwan ColorHub uses ICC profiles found in 6 different locations listed below : 

- /Users/$USER/Library/Application Support/Alwan Color Expertise/AlwanColorHubX/Profiles  

- /Applications/Alwan Color Expertise/AlwanColorHubX/AlwanColorHubX.app/Contents/Resources/Profiles 

- /Users/$USER/Library/ColorSync/Profiles  

- /Library/Application Support/Adobe/Color  

- /Library/ColorSync/Profiles  

- /System/Library/ColorSync/Profiles 

 

Under Microsoft Windows Alwan ColorHub uses ICC profiles found in 3 different locations listed below :  

- %APPDATA%\Alwan Color Expertise\AlwanColorHubX\Profiles 

- C:\Program Files\Alwan Color Expertise\AlwanColorHubX\Resources\Profiles 

- C:\Windows\system32\spool\drivers\color 

 

If the same profile exists in different locations, only one profile will be displayed. Note that above locations are 
listed with decreasing priority. 

To know the location of a selected profile, put the mouse pointer on the profile name, a tooltip showing ICC 
profile location will be displayed: 

 

 

4.1.2. Import/Export settings with embedded profiles 
When settings are saved, ICC profiles are automatically embedded. During settings import, embedded profiles 
are automatically saved in ACH/X specific folder:  

- MAC OS X: /Users/$USER/Library/Application Support/Alwan Color Expertise/AlwanColorHubX/Profiles 
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- Windows OS: %APPDATA%\Alwan Color Expertise\AlwanColorHubX\Profiles 

Note: 

Before exporting and importing settings, please make sure that profiles embedded are royalty free and intended 
for public use. 

	

4.1.3. PDF/X compliancy 
PDF/X-1a: 2001, PDF/X3: 2002, 2003 and PDF/X4: 2008 are supported. 

Alwan ColorHub is compliant with the following internationally recognized test suites:  

- ECI Altona Visual and Technical,  

- GWG 2006 

- Kensington Suite 

Output CMYK Profile is always embedded as the Output Intent for PDF/X files regardless of the “Embed Output 
Profile” box setting. 

When PDF/X Output Intent profile is not embedded in the original PDF/X, ACH/X will look for the profile in all 
profiles folders as described in “ICC profiles used by Alwan ColorHub” paragraph. 

Please copy all the profiles you intend to use in your Profiles folder for an automatic recognition by the 
software: 

Windows: %APPDATA%\Alwan Color Expertise\AlwanColorHubX\Profiles 

OS X: ~/Library/Alwan Color Expertise/AlwanColorHubX/Profiles 

If Output Intent refers to a Profile not contained in your Profiles folders, the Log Manager will inform you. In 
this case, the Queue Default Input CMYK Profile is used. 

	

4.2. Advanced options for specific cases 
Please contact Alwan Color Expertise Support if you need to change these defaults settings: 
 JobTask_enfocusCertification option can be set to: 

 0:  Optimized PDF keeps its Enfocus® Certification tags (default setting) 

 1:  Alwan ColorHub puts any Enfocus® Certified PDF in JobError folder and does   
 not optimize it 

 2:  Alwan ColorHub deletes Enfocus® Certified PDF tags after Optimization: useful for some Adobe 
Acrobat® and Enfocus Pitstop® versions that show an inconsistent behavior when reading an optimized 
Certified PDF. 

By Default, this option is set to 0 

 

JobTask_markPDFFile can be set to: 
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 YES: Every PDF you process using Alwan ColorHub will be marked and recognized if submitted to a 
second optimization. 

 NO: PDF wont be mark when optimized with Alwan ColorHub. 

 

JobTask_treatMarkedPDF can be set to: 

 YES: All PDF wether marked or not will be processed with Alwan ColorHub. 

 NO: PDF previously processed by Alwan ColorHub, won’t be processed again. This option is useful in 
order to prevent a second undesirable optimization from occurring  

By default, JobTask_markPDFFile is set to NO and JobTask_ treatMarkedPDF is set to YES. 

	
 
	


